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Der	System	Informer	ist	eine	kostenlose	Open-Source-Software,	die	bei	der	berwachung	von	Systemressourcen,	beim	Debugging	von	Software	und	bei	der	Erkennung	von	Malware	hilft.	Die	Freeware	ist	der	Nachfolger	von	Process	Hacker,	bietet	detaillierte	Einblicke	in	die	Systemaktivitten	und	stellt	diese	bersichtlich	dar.	Bild	1	von	1	System
Informer	berwacht	SystemressourcenMit	System	Informer	lassen	sich	Ressourcenfresser	und	auer	Kontrolle	geratene	Prozesse	schnell	aufspren.	Grafiken	und	Statistiken	zeigen	die	Auslastung	von	CPU,	RAM	und	Netzwerk	in	Echtzeit.	Per	Doppelklick	auf	einen	Datenpunkt	in	den	Grafiken	erhlt	man	Informationen	ber	den	zugehrigen	Prozess,	selbst
wenn	dieser	bereits	beendet	wurde.Identifizierung	von	DateisperrenSystem	Informer	hilft	dabei	herauszufinden,	welcher	Prozess	eine	Datei	gerade	verwendet	und	dadurch	fr	andere	Prozesse	sperrt.	Im	Notfall	lsst	sich	die	Sperre	auch	zwangsweise	aufheben,	was	jedoch	mit	Vorsicht	zu	genieen	ist,	da	dadurch	Datenverluste	oder	Inkonsistenzen
entstehen	knnen.Netzwerkverbindungen	im	BlickDie	Software	zeigt	an,	welche	Programme	aktive	Netzwerkverbindungen	haben.	Diese	lassen	sich	bei	Bedarf	beenden.	Zustzlich	gibt	es	detaillierte	Statistiken	zum	Datenverkehr,	die	Auskunft	ber	die	Auslastung	einzelner	Netzwerkadapter	geben.Weitere	Funktionen	vom	System	InformerDer	System
Informer	verfgt	ber	eine	Vielzahl	weiterer	Funktionen:	So	zeigt	die	Software	den	Festplattenzugriff	und	die	Auslastung	der	Grafikkarte	in	Echtzeit	an.	Auerdem	gibt	es	eine	Baumansicht	mit	allen	laufenden	Diensten,	die	sich	steuern	und	bearbeiten	lassen.	Zudem	ermglicht	System	Informer	die	Anzeige	von	Stack-Traces	mit	Untersttzung	fr	Kernel-
Mode,	WOW64	und	.NET.Portabel	und	anpassbarSystem	Informer	lsst	sich	als	Setup-Datei	zur	Installation	oder	als	installationsfreie,	portable	Software	herunterladen.	Die	Einstellungen	lassen	sich	in	einer	separaten	XML-Datei	speichern,	sodass	man	diese	beispielsweise	zusammen	mit	dem	Programm	auf	einem	USB-Stick	ablegen	kann.	Weiterhin
untersttzt	System	Informer	Themes,	um	das	Erscheinungsbild	nach	den	eigenen	Vorlieben	anzupassen.Alternativen	zu	System	InformerVergleichbare	Tools	sind	der	Process	Explorer	und	der	Process	Monitor	von	Microsoft,	die	ebenfalls	tiefe	Einblicke	in	die	Systemaktivitten	erlauben.	Diese	sind	jedoch	eher	auf	die	Prozessberwachung	spezialisiert,
whrend	System	Informer	einen	breiteren	Funktionsumfang	bietet.	Autoruns	ist	ein	kleines	Windows-Tool,	das	alle	Programme	und	Dienste	auflistet,	die	beim	Hochfahren	des	Systems	automatisch	gestartet	werden.	Der	Process	Explorer	ist	ein	alternativer	Task-Manager	der	Sysinternals	Suite,	der	erweiterte	Informationen	zu	aktiven	Prozessen	und
Bibliotheken	liefert.	Der	Process	Hacker	ist	ein	Task-Manager	fr	Windows,	der	laut	Hersteller	auch	Prozesse	schliet,	bei	denen	andere	Task-Manager	versagen	Zum	zeitgesteuerten	Ausfhren	bestimmter	Aktionen	auf	dem	Rechner,	etwa	zum	automatischen	Starten	von	Programmen,	zum	Abspielen	von	Musikdateien	zu	einer	Durchleuchtet	das	System
nach	kritischen,	veralteten	und	berflssigen	Autostart-Eintrgen	und	bearbeitet,	de-,	reaktiviert	oder	lscht	sie	vollstndig	Get	started	today	Set	up,	deploy	and	upgrade	all	your	devices	from	an	intuitive,	lightning-fast	cloud	platform.	FREE	TRIAL	Mit	dem	System	Informer	blicken	Sie	in	die	softwaretechnischen	Innereien	Ihres	RAMs.	Foto:
iStock.com/undefined	undefinedDer	Process	Hacker	ist	ein	Tool,	das	einen	Ersatz	fr	den	Task-Manager	von	Windows	darstellt;	das	Utility	eignet	sich	auch	als	Ergnzung.	Die	Software	trgt	seit	geraumer	Zeit	einen	neuen	Namen:	System	Informer.	Wir	stellen	sie	vor.Welche	Programme	laufen	vordergrndig	oder	im	Hintergrund,	wie	viele	Ressourcen
bezogen	auf	die	einzelnen	PC-Bauteile	bentigen	sie	jeweils	und	wie	sieht	es	hinsichtlich	der	Inanspruchnahme	von	RAM,	CPU	sowie	Harddisk	insgesamt	aus?	Das	sind	Fragen,	die	sich	User	stellen,	bei	denen	der	PC	lahmt.	Auch	wer	verhindern	will,	dass	es	zu	einer	Performance-Minderung	kommt,	beschftigt	sich	mit	solchen	Dingen.	Antworten	auf
diese	Fragen	erhalten	Sie	vom	Windows-Task-Manager.	Auf	Wunsch	nutzen	Sie	zustzlich	oder	alternativ	eine	nach	einem	vergleichbaren	Prinzip	arbeitende	Software.	Mitunter	befinden	sich	darin	praktische	Funktionen,	die	ber	diejenigen	des	Bordmittels	hinausgehen;	damit	sind	idealerweise	mehr	Tuning-Facetten,	mehr	Informationen	und	mehr
Komfort	verbunden.Im	Artikel	"Windows-Task-Manager-Alternativen:	Die	besten	Programme"	haben	wir	jngst	diverse	taskmgr.exe-Konkurrenten	vorgestellt.	Im	Beitrag,	den	Sie	gerade	lesen,	gehen	wir	nher	auf	den	Process	Hacker	ein.	Oder	genauer:	auf	den	System	Informer.	Die	erstgenannte	Software	wird	nicht	mehr	weiterentwickelt	und	es	hat
einen	Namenswechsel	gegeben.	Die	aktuelle	Bezeichnung	der	Anwendung,	"System	Informer",	klingt	sehr	viel	braver	als	Process	Hacker.	Im	Folgenden	klren	wir,	was	funktional	damit	geht	und	wo	Differenzen	vorliegen.Der	Process	Hacker	und	der	System	Informer	sehen	sich	in	Gestaltung	sowie	Aufbau	der	Oberflche	hnlich.	Beide	formatieren	die	in
ihnen	aufgefhrten	Prozess-Eintrge	mit	Farben.	Mchtiger	in	puncto	Registerkarten	erscheint	der	System	Informer.	So	bietet	der	Process	Hacker	die	folgenden	Tabs,	auf	die	sich	wechseln	lsst:ProcessesServicesNetworkDiskDer	System	Informer	toppt	das,	indem	er	zwei	Tabs	obendrauf	packt.	Die	Auswahl	an	Registerkarten	stellt	sich	folgendermaen
dar:ProcessesServicesNetworkDiskFirewallDevicesMit	dem	System	Informer	erhalten	Sie	einen	Einblick	in	die	Programmprozesse	auf	Ihrem	Rechner.Beide	Anwendungen	zeigen	in	einer	Tabelle,	welche	Programme	auf	dem	System	gerade	laufen.	Die	Prozessorlast,	die	von	den	zugehrigen	EXE-Dateien	im	RAM	im	Einzelnen	ausgeht,	ist	jeweils	in	der
Spalte	"CPU"	ersichtlich.ber	das	Kontextmen	der	Eintrge	der	aktiven	Applikationen	lsst	sich	hier	wie	da	die	Anzahl	der	zugewiesenen	Prozessorkerne	ndern,	ferner	die	Prozess-Prioritt.	Unliebsame	Programme	beenden	Sie	bei	dem	Duo	ber	einen	Kontextbefehl.	Im	Men	findet	sich	nur	beim	Process	Hacker	unter	"Miscellaneous"	die	Funktion	"Inject
DLL":	Das	Feature	ist	fr	Profis	reizvoll	hierber	lsst	sich	in	einen	Prozess	eine	DLL-Datei	einschleusen.	Es	fllt	schwer,	dafr	einen	sinnvollen	Einsatzzweck	im	Alltag	zu	finden.Fr	den	Fall,	dass	man	jemals	einen	kennt,	ist	es	aber	vorteilhaft,	den	Process	Hacker	im	Hinterkopf	zu	haben.	Fr	an	Systemnahem	Interessierte	das	Ausprobieren	wert:	Das
Programm	"AdvancedRun"	von	Nirsoft	startet	Programme	und	schleust	sie	hierbei	auf	Wunsch	per	Injektion	als	Kind-Prozesse	von	bereits	laufenden	Anwendungen	ein;	dabei	wird	quasi	gewaltsam	ein	Eltern-EXE-Prozess	im	RAM	erkoren.ber	das	Kontextmen	lassen	sich	Programme	beenden,	neu	starten	und	effizient(er)	machen.Dem	System	Informer
ist	das	Einschleusen	von	DLL-Dateien	abhandengekommen,	dafr	wartet	er	im	Kontextmen	von	Prozessen	mit	einem	wiederum	fr	sich	im	Vergleich	zu	seinem	Vorgnger	exklusiven	Feature	auf:	"Efficiency".	Damit	versetzen	Sie	einzelne	Programme	in	den	Effizienzmodus.	Dabei	verfllt	die	Prozess-Prioritt	auf	"Niedrig".	Den	Effizienzmodus	gibt	es	offiziell
seit	Windows	11,	bordmittelseitig	stlpen	Sie	ihn	mithilfe	des	Task-Managers	nur	bei	diesem	System	Ihren	Anwendungen	ber.Das	taskmgr.exe-Pendant	von	Windows	10	bietet	so	etwas	noch	nicht	an.	Neben	dem	System	Informer	trimmt	auch	das	Tool	"Process	Lasso"	Prozesse	auf	Effizienz,	doch	nur	unter	Windows	11.	Mit	dem	System	Informer
funktioniert	so	etwas	wiederum	unter	Windows	11	und	(!)	unter	Windows	10.	Fr	Nutzer	des	letzteren	OS	stellt	dies	ein	echtes	Highlight	dar.Ein	Fenster	klrt	mithilfe	von	Visualisierungen	darber	auf,	wie	stark	der	PC	unter	Stress	steht.Beide	Task-Manager-Interpretationen	erlauben	es,	ber	die	in	der	Menleiste	anzuwendende	Klickfolge	"View	>	System
Information"	ein	Fenster	aufzurufen,	aus	dem	die	prozentuale	Last	auf	CPU,	RAM,	I/O,	GPU,	Disk	und	Netzwerk	hervorgeht.	Es	kommen	jeweils	zahlreiche	Ausknfte	zusammen	und	auch	in	Sachen	Aussehen	macht	das	Gebotene	Boden	gut;	visuell	erinnert	es	an	den	Task-Manager,	den	Windows	8	und	dessen	Nachfolger	an	Bord	haben.Damit	all	die
genannten	Kategorien	zu	sehen	sind,	gilt	es,	die	Task-Manager-artige	Software	mit	Administrator-Rechten	aufzurufen.	Ohne	diese	Privilegien	erhalten	Sie	keine	Ausknfte,	die	so	umfassend	sind,	wie	es	mglich	wre.Das	Sezieren	von	Software	ber	deren	zu	ladende	EXE-Datei	stellt	ein	weiteres	Metier	dar.Ohne	Weiteres	legen	Sie	unter	Windows	keine
Dienste	an,	also	im	Hintergrund	und	ohne	eine	eigene	Oberflche	(oder	eine	Tray-Symbol-Entsprechung)	laufende	Programme.	Mit	dem	Process	Hacker	und	dem	System	Informer	ist	das	aber	mglich.	Wobei	Sie	hierfr	einen	guten	Grund	haben	sollten;	im	Regelfall	ist	es	nicht	notwendig,	derart	"an	den	Diensten	herumzuspielen".Die	Klickfolge	"Tools	>
Create	Service"	bahnt	Ihnen	hier	den	Weg.	Beide	Anwendungen	informieren	Sie	zudem	mithilfe	einer	Toast-Notification,	wenn	neue	Dienste	errichtet	wurden	eine	Art	Autostart-Firewall.Unter	"Tools"	findet	sich	in	den	Menleisten	des	Weiteren	mit	"Inspect	executable	file"	die	Mglichkeit,	eine	einzuladende	EXE-Datei	unter	die	Lupe	zu	nehmen.	Davon
profitieren	insbesondere	versierte	Personen.	Ein	Anfnger	wird	mit	dem	Output	nichts	anzufangen	wissen.Belastet	das	WSL	(VMMEM)	den	PC,	kommen	Sie	dagegen	mit	einer	Beendigung	an.Nutzen	Sie	unter	Windows	in	der	Kommandozeile	das	WSL,	was	fr	Windows	Subsystem	for	Linux	steht,	vereinnahmt	diese	Betriebssystem-Schicht	fr	die
Ausfhrung	von	Linux-Programmen	unter	Windows	einigen	Arbeitsspeicher.Der	Prozess	"VMMEM"	nimmt	mehrere	Hundert	Megabyte	an	RAM	in	Beschlag.	Damit	kommen	Sie	mit	dem	System	Informer	an:	Die	Klickfolge	"Tools	>	Terminate	WSL	processes"	beendet	VMMEM	und	schaufelt	nennenswert	viel	flchtigen	Speicher	frei.	Mit	dem	Process
Hacker	lsst	sich	dieses	Tuning-Manver	nicht	anwenden,	er	scheint	(nicht	nur	hier)	einen	Hauch	weniger	am	Puls	der	Zeit	entwickelt.Der	System	Informer	ist	nicht	in	allen	Belangen	besser	als	der	Process	Hacker,	aber	in	einigen,	und	insgesamt	macht	die	neuere	Software	das	Rennen.	Der	Process	Hacker	bringt	in	der	Menleiste	weniger	Eintrge	mit
und	zeigt	in	aufrufbaren	Unterfenstern	kein	Titelleisten-Symbol	an	(vergleichbar	mit	dem	Ausfhren-Dialog	von	Windows	XP),	wohingegen	sich	der	System	Informer	dieses	Stilmittels	bedient	(so	wie	der	Ausfhren-Dialog	von	Windows	Vista	und	hher).	Der	parallele	Einsatz	der	Tools	ist	mglich,	in	der	Regel	gengt	es	aber,	lediglich	zum	System	Informer
zu	greifen.Eine	Alternative	bekommen	Sie	zum	Beispiel	mit	MiTec	Task	Manager	Deluxe.	Die	portable	und	professionell	aufgemachte	Software	bringt	eine	Schaltflche	mit,	mit	der	Sie	schnell	mal	RAM	freigeben.	Dieses	Freirumen	von	Arbeitsspeicher	funktioniert	anders	als	jenes,	wie	es	der	System	Informer	im	Hinblick	auf	das	Terminieren	von	WSL-
RAM-Interna	praktiziert.Eine	hnlich	dem	System	Informer	serise	Attitde	weist	der	Process	Explorer	auf,	angeboten	von	Microsoft	und	ein	guter	Kumpane	fr	das	bordinterne	taskmgr.exe.	Wer	den	Process	Explorer	bereits	kennt	und	nach	einem	Ersatz	fr	ihn	sucht,	liegt	beim	System	Informer	richtig.	Ein	Blick	fr	Freunde	der	ersteren	portablen
Freeware	lohnt	sich;	der	System	Informer	sollte	Sie	in	puncto	Tiefgang	nicht	enttuschen.	You	cant	perform	that	action	at	this	time.	Systeminformer	Portables,	no	dinero	Open-Source-Tool	(MIT)	zur	deep	down	walkenden	Analyse,	Feinjustierung	von	Systemprozessen	und	Performance-Tuning.	Dieser	Lmmel	erkennt	versteckte	Prozesse,	analysiert
Handles,	Threads,	DLLs	und	Treiber,	berwacht	CPU-,	RAM-,	GPU-,	I/O-	&	Netzwerkressourcen	im	Detail	und	tischt	deutlich	weit	mehr	Funktionen	als	der	Windows-Task-Damager	auf,	was	supersexy	fr	IT-Profis,	Entwickler	und	Power-schmUser	ist.Beim	Onkel	kommt	das	scharfe	Teil	immer	dann	zum	Dreisatz,	wenn	frisch	zusammengezimmerte
Windows-Systeme	erst	einmal	auf	Herz	und	Bizeps	geprft	werden,	beim	Performance-Tuning,	wenn	fremde	Systeme	unerwartet	am	abkacken	sind,	zur	berwachung	nach	nderungen/Anpassungen	am	Testsystem	oder	wenn	es	um	fiese	Security-Angelegenheiten	geht.Ein	paar	fesche	Bling-Bling-Features	je	nach	Benutzergruppen:Fr	Power-
User:Startzeit-Analyse:	Prozess-Startzeiten	&	Autostarts	analysierenModernes	UI:	Whlbare	Dark-/Light-Themes	+	bersichtliche	IconsGPU-Monitoring:	Auslastung	im	Blick	fr	Gaming,	Video	&	TemperaturkontrollePortabel	&	direkt	einsatzbereit:	Luft	ohne	Setup,	ideal	vom	USB-Joy-Stick-of	LoveProzess-Einstellungen:	Eingestellt	Prioritt,	CPU-Kerne
und	I/O-Settings	knnen	gespeichert	und	automatisch	anwendet	werdenProzessbaum-Darstellung:	Abhngigkeiten	und	Eltern-Kind-Prozesse	auch	fr	Malen-nach-Zahlen-Fans	wie	mich	besser	zu	understndenHandle-Suche	&	Netzwerk-berwachung:	Offene	Handles	und	Netzwerkverbindungen	gezielt	anzeigen	(nein	nicht	bei	der	Polizei)	und
analysierenProzessanalyse	&	Performance-Tuning:	Prozesse	priorisieren,	CPU-Kerne	zuweisen,	und	so	ressourcenhungrige	Apps	wie	Bud	Spencer,	auf	Dit	setzenFr	IT-OGs:Signahurprfung:	Herausfinden,	ob	Prozesse	und	DLLs	gltig	signiert	sindThread-berwachung:	Einzelne	Threads	analysieren	und	gezielt	verwaltenProzessbersicht:	Prozesse	mit
eiserner	Hand	verwalten,	beenden,	priorisieren,	debuggenHandle-	und	DLL-Suche:	Herausfinden,	welcher	Prozess-Stricher	eine	Ressource	blockiertPortabel	&	leichtgewichtig:	Luft	ohne	Installation.	Ideal	fr	den	USB-Stick-of-Love-EinsatzMemory-Dumps	erstellen:	Speicherabbilder	direkt	aus	Prozessen	generieren	(z.B.	bei	Abstrzen)Service-
Verwaltung:	KamelTreiber	anzeigen	sowie	Dienste	anzeigen,	starten,	stoppen	oder	deaktivierenNetzwerk-berwachung:	Aktive	Verbindungen	berwachen	und	bei	Bedarf	gezielt,	wie	eine	schlechte	Beziehung,	einfach	trennenFr	Entwickler:Festplatten-I/O:	Analyse	von	Lese-/Schreibzugriffen	einzelner	ProzesseModul-Ansicht:	Durchgeladene	DLLs	und
Abhngigkeiten	je	Prozess	analysierenStack-Traces:	Tiefe	Einsicht	mit	Kernel-,	.NET-	und	WOW64-UntersttzungToken-	und	Rechteverwaltung:	Sicherheitskontexte	von	Prozessen	einsehenPDB-Support:	Automatischer	Download	von	Symbol-Dateien	fr	przises	DebuggingDebugger-Anbindung:	Prozesse	direkt	mit	einem	Debugger	verbinden	(z.B.	Visual
Studio	Code)Ressourcen-Performance-Grafiken:	Pimp-miger	Drill-Down	auf	CPU,	RAM,	GPU,	Netzwerk	&	Disk	Screenshot	System	Informer-	Prozessliste:	Einfaches	Beispiel,	wie	man	Windows-Performance-Bottlenecks	mit	dem	immergeilen	System	Informer	erkennt1.	Systemstatus	checken	(System	Informer	System	Information)	CPU-,	RAM-,	Disk-,
Netzwerk-	und	GPU-Gesamtauslastung	als	Graph	von	einsehen	Hover-Tooltips	zeigen	die	Last	pro	Komponente.	GPU-Anzeige	systemweit	sichtbar	Uptime	prfen	Isst	das	System	berlastet	oder	lange	aktiv?	Urlaubstag	wegen	Work-Life-Balance	und	so	einplanen2.	Bottleneck	eingrenzen	CPU	Dauerhaft	hohe	Auslastung?	Pfui!	RAM	Hohe	Auslastung?
Fast	so	voll	wie	ein	russischer	Elternabend?	Disk	I/O	Dauerfeuer	auf	die	Disk.	Viele	Reads/Writes	am	Start?	Netzwerk	Ungewhnlicher	und	oder	hoher	Traffic?	GPU	Hoher	Load	im	System	Information-Graph?3.	Den	Schurken/Verursacher	finden	(System	Informer	Processes)	Verdchtige	Prozesse:	Rechtsklick	(nichts	fr	Woke)	Properties	Threads,
Handles,	I/O,	Stack-Traces	analysieren	Nach	CPU	oder	I/O	sortieren	(RAM-Spalten	nein	kein	Kernspaltung	wie	Working	Set	oder	Private	Bytes	und	GPU-Spalte	vorher	aktivieren)4.	Netzwerkverkehr	analysieren	(System	Informer	Network)	Welche	Prozesse	haben	aktive	Verbindungen?	Unerwartete	Remote-Ziele	oder	viele	offene	Verbindungen
durchchecken5.	Hintergrundprogramme	checken	System	Informer	Services:	Unntige	Dienste	stoppen	oder	deaktivieren	Task-Manager	Reiter	(wenn	kein	Pferd	Radfahrer	geht	auch)	Autostart:	Programme	mit	hoher	Startauswirkung	deaktivieren6.	Performance	optimieren	Prozesse	priorisieren	(Set	Priority)	CPU-Affinitt	anpassen	(Set	Affinity)
Prozesse	pausieren	oder	beenden,	falls	diese	blockierenHinweis:	Das	Vorgehen	fokussiert	sich	nur	auf	den	System	Informer.	Normalerweise	kommen	bei	mir	auch	noch	weitere	Tools	wie	Event	Viewer	(Systemfehler),	Libre	Hardware	Monitor	(GPU-Metriken	wie	VRAM/Temperaturen)	u.s.w.	mit	ins	Analyse-Boot.
AnalyseBenchmarkPortableSecurityTuningUSB	A	free,	powerful,	multi-purpose	tool	that	helps	you	monitor	system	resources,	debug	software	and	detect	malware.	Download	System	Informer	Use	Ctrl+I	to	view	system	performance	information.	Move	your	cursor	over	a	graph	to	get	a	tooltip	with	information	about	the	data	point	under	your	cursor.	You
can	double-click	the	graph	to	see	information	about	the	process	at	that	data	point,	even	if	the	process	is	no	longer	running.	Use	Ctrl+F	to	search	for	a	handle	or	DLL.	If	all	else	fails,	you	can	right-click	an	entry	and	close	the	handle	associated	with	the	file.	However,	this	should	only	be	used	as	a	last	resort	and	can	lead	to	data	loss	and	corruption.	Use
Ctrl+I	to	view	system	performance	information.	Move	your	cursor	over	a	graph	to	get	a	tooltip	with	information	about	the	data	point	under	your	cursor.	You	can	double-click	the	graph	to	see	information	about	the	process	at	that	data	point,	even	if	the	process	is	no	longer	running.	Add	extra	columns	to	show	even	more	system	activity	and	information!
This	may	look	very	similar	to	the	Disk	Activity	feature	in	Resource	Monitor,	but	System	Informer	has	a	few	more	features!	Enable	disk	statistics	for	detailed	disk	usage	information.	Hover	your	cursor	over	the	first	column	(with	the	numbers)	to	view	parameter	and	line	number	information	when	available.	Enable	network	adapter	statistics	for	detailed
information	network	usage	information.	By	default,	System	Informer	shows	entries	for	drivers	in	addition	to	normal	user-mode	services.	You	can	turn	this	off	by	checking	View	>	Hide	Driver	Services.	By	default,	System	Informer	shows	gpu	usage	for	all	processes.	Hover	your	cursor	over	the	graph	for	detailed	information	when	available.	System
Informer	supports	light	and	dark	themes	and	has	options	for	modern	icons.	System	Informer	is	a	free,	open-source	Windows	utility	for	deep	system	inspection,	real-time	monitoring,	and	troubleshooting.	It	provides	a	detailed,	live	view	of	processes,	threads,	services,	modules,	and	open	handles,	along	with	system-wide	resource	graphs	for	CPU,
memory,	disk,	and	network	activity.	With	powerful	control	options	and	a	streamlined	interface,	it	helps	developers,	IT	professionals,	and	power	users	diagnose	performance	issues,	resolve	file-in-use	errors,	and	understand	exactly	whats	running	on	their	PCs.Key	features:Advanced	process	explorer:	tree	view,	perprocess	stats,	properties,	stacks,
environment,	and	module	listsService	and	startup	managers:	view,	start/stop,	and	configure	services	and	autorunsHandle	and	DLL	search:	find	which	process	is	locking	a	file	or	using	a	specific	moduleNetwork	monitor:	inspect	connections,	listening	ports,	and	perprocess	network	activityMemory	and	thread	tools:	view	memory	regions,	heaps,	strings,
and	thread	activity;	create	dump	files	for	analysisSecurity	insights:	token	details,	integrity	levels,	privileges,	and	digital	signature	informationReal-time	system	graphs:	system-wide	CPU,	memory,	I/O,	and	network	usageExtensible	and	portable:	plugin	support,	installer	and	portable	builds,	dark	theme,	and	high-DPI	awarenessSystem	Informer	runs	on
modern	versions	of	Windows	and	is	an	ideal	companionor	replacementfor	Task	Manager	when	you	need	deeper	visibility	and	control.System	Informer	is	developed	by	System	Informer.	The	most	popular	versions	of	this	product	among	our	users	are:	3.0,	3.1	and	3.2.	The	names	of	program	executable	files	are	peview.exe,	SystemInformer.exe.	You	can
check	Software	Informer,	SYS	Informer,	Bride.Ru	Informer	and	other	related	programs	like	Memory	Informer	at	the	"download"	section.Page	2Choose	the	most	popular	programs	from	Audio	&	Video	softwareLatest	version:Developer:System	InformerTop	

How	to	identify	exothermic	and	endothermic	reaction.	What	is	exothermic.	What	is	meant	by	the	word	exothermic.	Describe	exothermic	reactions.	What	type	of	reaction	is	thermal	decomposition	endothermic	or
exothermic.	What	is	exothermic	or	endothermic.	Is	thermal	decomposition	endothermic	or	exothermic.	Is	decomposition	endothermic	or	exothermic.	Is	decomposition	exothermic.	Endothermic	exothermic

reaction.	Is	decomposition	an	endothermic	reaction.
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